
  Grades 6 - 8 
 

 
Creating a Hyperlink Document 

 

TMT3 Grades 6 - 8: Hyperlink Document  183 

1. Create a document in Word, referencing Internet sites or folders you wish to 
hyperlink. 

 
2. Using your mouse, highlight the text you want to hyperlink. Right-click with your 

mouse. 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select Hyperlink from the drop-down list. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

4. Select the file you wish to hyperlink to and click OK. If you want to hyperlink to 
a website, type the website address in the field titled Address. Then click OK. 

 



  Grades 6 - 8 
 

 
Using the CBR 

TI-73 
 

TMT3: Grades 6 – 8: Using the CBR  184  

1. Connect the CBR to the TI-73 using the calculator-to-CBR cable. Make sure both 
ends are pressed firmly to make the connection. 

 
2. Press 9. 

 
3. Select CBL/CBR. 
  
 
 
 
 
 
 
 
4. Press any key. Then select Ranger. 
 
 
 
 
 
 
 
 
 
5. Follow the on-screen instructions. Press b. 
 
 
 
 
 
 
 
 
 
6. Select 1: Setup/Sample. 
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7. If necessary, change REALTIME to “no” by pressing †  to move to the 
REALTIME row and pressing b. 

 
8. Use † to arrow to the TIME row. Change the time to 5 seconds. 

 
9. Use $ to arrow to START NOW. Press b. 

 
10. Point the CBR at the target and press b.  

 
11. The CBR will collect data for 5 seconds. A graph of the data will appear.  

 
12. Press b to return to the plot menu. 

 
 
 
 
 
 
 
 
 
13. Select 7: QUIT or choose other options as desired. 
 
14. The calculator will tell you the lists where it has stored the data.  

 
15. Press b. Then press 3 to see the data.  

 
  

 
 
 
 
 
 
 
16. Repeat as necessary.  
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Technology Tutorial:  Internet Explorer: Data Station B 
 
Hit the Dot, http://faculty.washington.edu/chudler/java/dottime.html, collects cumulative 
data as individuals play the game. The cumulative data represents the scores earned on 
first attempts at Hit the Dot. To prevent an individual from recording more than one 
score, the website places a “Cookie” on the computer that indicates that you have already 
posted a score to the website. You may play the game as many times as you like; 
however, the website’s cumulative data only adds your first score. 
 
Because more than one individual is playing the game at this computer, it becomes 
necessary to delete the Cookie after each individual plays the game. This will allow the 
score for each individual to become part of the cumulative data. 
 

1. In Internet Explorer, click on the Tools menu to view the drop-down menu. Click 
Internet Options. 
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2. On the 
General tab, 
click Settings. 

 

 

 

 

 

 

 

 

3. Click View 



  Grades 6 - 8 
 
 
 

TMT3: Grades 6 – 8: Data Station B  188 

Files. 

 

 

 

 

 

 

 

 

 

 

 

4. Select the Cookie that contains “ @washington.edu” in the nam 

 

 

e.  

 

 

 

 

 

 

5. Click on the File menu, click Delete.  
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6. Click on the Yes button to delete the selected Cookie. 
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1. Press É. 
2. Press 3. If data is in the columns, you will need to clear the data by moving the 
cursor to the top with the arrow keys until L1 is highlighted, press ‘ then e. 
Repeat to clear all data from the other lists if needed. 
 
 
 
 
 
 
 
 
 
3. Enter data in L1 and L2. After each value is typed, press e. 
 
 
 
 
 
 
 
 
 
4. To access the Plot menu, press `! . 
 
 
 
 
 
 
 
 
 
5. Press e. 
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6. Turn the plot on by using the arrow keys to move the cursor over On and pressing 
e. 
 
 
 
 
 
 
 
 
7. Arrow down to TYPE, then use your ~ key to move to the first box and whisker plot. 
Press e. 
 
 
 
 
 
 
 
 
8. Arrow down to XLIST. The calculator defaults to L1. If your data is in another list, you 
will need to press `3, select the appropriate list, then press e. 
 
 
 
 
 
 
 
 
 
9. To set your window, press p. Xmin is the minimum x-value that you want 
displayed in your viewing window. Xmax is the maximum x-value that you want 
displayed in your viewing window. 
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The range of the heights was from about 145 centimeters to 210 centimeters. Xscl defines 
the distance between tick marks : 10 is an appropriate Xscl for this window. Use }or † 
to move the cursor to the variable you want to change. Type the new value on each line, 
then press e  after each change. 
 
 
 
 
 
 
 
 
 
For box and whisker plots, Ymin and Ymax are ignored, so you will not need to make 
any changes. 
 
10. You may need to remove graphs located in !. If so, press ! then clear out all 
equations by pressing ‘ for each line. 
 
 
 
 
 
 
 
 
 
11. Press % to view the graph.  
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1. Press É. 
2. Press …. 
 
 
 
 
 
 
 
 
3. Press 1 to select Edit. 
 
 
 
 
 
 
 
 
If data is in the columns, you will need to clear the data by moving the cursor to the top 
with the arrow keys until L1 is highlighted, press ‘ then e. Repeat to clear all 
data from the other lists if needed. 
 
4. Enter data in L1 and L2. After each value is typed, press e. 
 
 
 
 
 
 
 
 
 
5. To access the Stat Plot menu, press `! . 
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6. Press e. 
 
7. Turn the plot on by using the arrow keys to move the cursor over On and pressing 
e. 
 
 
 
 
 
 
 
 
8. Arrow down to TYPE, then use your ~ key to move to the second box and whisker 
plot. Press e. 
 
 
 
 
 
 
 
 
9. Arrow down to XLIST. The calculator defaults to L1. If your data is in another list, you 
will need to press `…, select the appropriate list, then press e. 
 
 
 
 
 
 
 
 
10. To set your window, press p. Xmin is the minimum x-value that you want 
displayed in your viewing window. Xmax is the maximum x-value that you want 
displayed in your viewing window. 
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The range of the heights was from about 145 centimeters to 210 centimeters. Xscl defines 
the distance between tick marks : 10 is an appropriate Xscl for this window. Use }or † 
to move the cursor to the variable you want to change. Type the new value on each line, 
then press e  after each change. 
 
 
 
 
 
 
 
 
 
For box and whisker plots, Ymin and Ymax are ignored, so you will not need to make 
any changes. 
 
11. You may need to remove graphs located in !. If so, press ! then clear out all 
equations by pressing ‘ for each line. 
 
 
 
 
 
 
 
 
 
12. Press % to view the graph.  
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1. Press É. 
 
2. To calculate one-variable statistics for data that has already been entered in your lists, 
press   `3. 
 
 
 
 
 
 
 
 
3. Use your right arrow button ~ to arrow over to CALC. 
 
 
 
 
 
 
 
 
 
4. Press 1. 
 
 
 
 
 
 
 
 
5.  Press `3   then select the list you wish to use. Press e. 
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6. Press e again. 
 
 
 
 
 
 
 
 
 
7. You can now use the $ and # keys to scroll through the statistics. 
 
8. The various calculations listed in this window are: 
 

Symbol Definition 
x  Mean 
x∑  Sum of x values 

2x∑  Sum of x2 values 

Sx Sample standard  
deviation of x 

σ x Population standard 
deviation of x 

n Number of data 
points 

minX Minimum of x 
values 

Q1 Lower (1st) Quartile 
Med Median 
Q3 Upper (3rd) Quartile 

maxX Maximum of x 
values 
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1. Press É. 
 
2. To calculate one-variable statistics for data that has already been entered in your lists, 
press  …. 
 
 
 
 
 
 
 
 
3. Use your right arrow button ~ to arrow over to CALC. 
 
 
 
 
 
 
 
 
4. Press 1. 
 
 
 
 
 
 
 
 
5.  Press `   …. then select the list you wish to use. Press e. 
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6. Press e again. 
 
 
 
 
 
 
 
 
 
7. You can now use the $ and # keys to scroll through the statistics. 
 
8. The various calculations listed in this window are: 
 

Symbol Definition 
x  Mean 
x∑  Sum of x values 

2x∑  Sum of x2 values 

Sx Sample standard  
deviation of x 

σ x Population standard 
deviation of x 

n Number of data 
points 

minX Minimum of x 
values 

Q1 Lower (1st) Quartile 
Med Median 
Q3 Upper (3rd) Quartile 

maxX Maximum of x 
values 
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Technology Tutorial:  Grams of Fat Activity 1 
 

Formatting Chart Cells 

1. Open the Excel    document Middle School-Explore Explain 2 Spreadsheet.xls. 
 

2. Select Sheet 1 containing the template: Grams of Fat. 
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3. Scroll over the flag in cell G4. The HINT implies that the formula needed for this cell 
is  =Sum(highlight range of cells),  which means to enter  =SUM(  and then 
highlight the cells necessary by clicking and dragging the mouse from cell C4 to cell 
F4. Followed by a close parenthesis and Enter. 
 

 
 
4. Scroll over the flag in cell C5. The HINT implies that the formula needed for this cell 

is  =(cell with number of people in interval 0 to 9)/(cell with total), which means to 
input =. Then click on cell C4, followed by the backslash, followed by cell G4, and 
Enter. 
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5. Scroll over the flag in cell D5. The HINT implies that the formula needed for this cell 
is  =(cell with number of people in interval 10 to 19)/(cell with total), which means 
to enter =. Then click on cell D4, followed by the backslash, followed by cell G4, and 
Enter. 

 

 
 
6. Scroll over the flag in cell E5. The HINT implies that the formula needed for this cell 

is  =(cell with number of people in interval 20 to 29)/(cell with total), which means 
to input =. Then click on cell E4, followed by the backslash, followed by cell G4, and 
Enter. 
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7. Scroll over the flag in cell F5. The HINT implies that the formula needed for this cell 
is  =(cell with number of people in interval 30 to 39)/(cell with total), which means 
to enter =. Then click on cell F4, followed by the backslash, followed by cell G4, and 
Enter. 

 

 
 
8. Scroll over the flag in cell G5. The HINT implies that the formula needed for this cell 

is  =Sum(highlight range of cells),  which means to enter  =SUM(  and then 
highlight the cells necessary by clicking and dragging the mouse from cell C5 to cell 
F5. Followed by a close parenthesis and Enter. 
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9. Note: Until data is entered, cells will show an error message due to division by zero. 
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Formatting Mean, Median and Mode 

1. Open the Excel    document Middle School-Explore Explain 2 Spreadsheet.xls. 
 
2. Select Sheet 2 containing the templates: Data Pieces and Measures of Central 

Tendency. 
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3. Scroll over the flag in cell H5. The HINT implies that the formula needed for this cell 
is  =Average(highlight range of cells),  which means to enter  =Average(  and then 
highlight the cells necessary by clicking and dragging the mouse from cell B4 to cell 
E27. Followed by a close parenthesis and Enter. 
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4. Scroll over the flag in cell H6. The HINT implies that the formula needed for this cell 
is  =Median(highlight range of cells),  which means to enter  =Median(  and then 
highlight the cells necessary by clicking and dragging the mouse from cell B4 to cell 
E27. Followed by a close parenthesis and Enter. 
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5. Scroll over the flag in cell G5. The HINT implies that the formula needed for this cell 
is  =Mode(highlight range of cells),  which means to enter  =Mode(  and then 
highlight the cells necessary by clicking and dragging the mouse from cell B4 to cell 
E27. Followed by a close parenthesis and Enter. 

 
* Note: If the data set contains more than one mode, only the one with the lowest value 

will be recorded. 
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6. Note: Until data is entered, cells will show an error messages. 
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Technology Tutorial:  Fat Grams Graph Activity 2 
 

Creating the Grams of Fat Graph: 
Participants are allowed to select the type of graphical representation of their choice; 
therefore two possible types of graphs are shown: Histogram and Pie Graph. 
 
I.  Histogram 

1. Open the Excel    document Middle School-Explore Explain 2 Spreadsheet.xls.  
 

2. In order to use the Data Analysis Toolpak to create a histogram, you will need to 
create Bin Values. The Bin Value represents the highest value of each interval in the 
data set.  
For example, if the intervals sort the data from 0 to 9, 10 to 19, 20 to 29, and  
30 to 39, there would be four Bin Values: 9, 19, 29, and 39 as seen on the lower left 
hand side of Sheet 3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

For this example the following 
data pieces will be use.
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3. In the toolbar under the Tools menu select Data Analysis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Select Histogram and click OK. 
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5. Click the Input Range icon  . Highlight the cells that contain your data, by 
clicking on cells B4 and dragging down to E18. The numbers will be highlighted by 

“marching ant” tracks. Then click on the Import icon  . 
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6. Click the Bin Range icon  . You may need to select Sheet 3 before, highlighting 

the cells that contain your Bin values and then click on the Import icon  . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Under Output Options select Output Range, and click the Output Range  

icon  . The Output Range allows you to choose where the histogram will appear 
on the spreadsheet. You may need to select Sheet 3 before selecting the empty cells 

below the Graph section of the spreadsheet, and then click on the Import icon  .  
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8. Then select Chart Output and click OK. 
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9. Double Click on the middle of a bar in the graph. Select Options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Choose Option and change Gap Width to 0. Click OK. 
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11. To adjust the size of the graph, click in the area between the graph and the border. 
Click and drag a corner handle until the graph is the correct size. 

 
 
II.  Pie Graph 

1. Open the Excel    document Middle School-Explore Explain 2 Spreadsheet.xls. 
 
2. Select Sheet 2, and highlight data pieces by clicking on cell B4 and dragging down to 

cell E18. The numbers will be highlighted by “marching ant” tracks. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3. Select the Chart Wizard    in the toolbar 
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4. Step 1: Select the Pie chart type, and then click Next.  
Step 2: Since the data was highlighted first click Next. 
Step 3: Enter a Chart tile (Trials, Trials, Trials), then select the Data Labels tab and 
check Category name, Percentage and click Next. 
Step 4: Select As object in, and then Finish. 
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5. A graph will appear on the spreadsheet. 
 
6. To adjust the size of the graph, click in the area between the graph and the border. 

Click and drag a corner handle until the graph is the correct size. 
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Technology Tutorial:  Loading Data Analysis Toolpak 
 

Advance Preparation: Loading the Toolpak 
You must load the Data Analysis Toolpak before you can generate a histogram using 
Excel. If the Data Analysis Toolpak is not under the Tools menu, complete the following 
steps to load the Toolpak. 
 
1. Click Start, Programs, Microsoft Office, Microsoft Office Excel. 

2. Open an Excel   document. 
3. In the toolbar under the Tools menu, click Add-Ins. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. In the Add-Ins box, check Analysis Toolpak. Click OK 
 
 
 
 
 
 
 
 
 
 
 
 

5. The Data Analysis Toolpak can now be found in the Tools menu. 
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Technology Tutorial:  Loading TI Connect 
 

TI Connect is a linking software used to download and transfer data, and connect 
calculator, computer and internet platforms. 
 
Note: In order for TI Interactive 1.3 software to interface with the TI 
Connect software a 1.5 or higher version of TI Connect must be 
downloaded.  
 
Advance Preparation 

Google search: TI Connect, select TI Connectivity Kit (*) and Bookmark. 
Website: Appearance of the Texas Instruments website may differ. 
http://education.ti.com/us/product/accessory/connectivity/down/download.html 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. TI requires a registration/login process to the website. Registration/Login process 

follows: 
 
A. Google/Browse to website, if bookmarked use bookmark: 

http://education.ti.com/us/product/accessory/connectivity/down/download.html 
 

* 
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B. Select the appropriate computer platform (*). If a Security Alert window pops 
up click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

* 

* 

or 
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C. The registration/login process will begin at this point. Select New User 
Registration or input User Name and Password. Personal information and an 
agreement with terms will follow for new users. As illustrated below (*). If a 
Security Alert window pops up click YES. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

* 

* 
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2. Select the TI Connect(tm) language platform that is appropriate. Then click on the 
file name (*). Example: Windows (English) version was selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select Save (*), and save to the Desktop. Download will begin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* 
*

* 
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4. Once download is complete, close all windows. A TI Connect_eng.exe icon    
will appear on the desktop. 
 

5. Double click on the TI Connect_eng.exe icon   , and run set up. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. The TI Connect Set-up will go through several windows including a software license 
agreement. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(continue) 
 
 

* 

**
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7. Close all windows when setup is complete. 

 

8. A TI Connect icon    will appear on the desktop. 
 
9. Drag the TI Connect _eng.exe icon to the trash can, and delete. 

*

*

*

* 
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Technology Tutorial:  Loading TI Probability Simulator 
APPS 

The TI Probability Simulation APPS is an application software with interactive animation 
of the following probability situations: tossing coins, rolling dice, drawing marbles, 
spinning spinners, drawing cards, and generating random numbers. The TI Probability 
Simulator APPS requires the TI-73 Operating System 1.6. 
 
Advance Preparation 

• Check for TI Connect software on computer; if not loaded, load using Technology 
Tutorial Loading TI Connect. 

• If the computer has TI Interactive, make sure it is version 1.3 or higher. 
• Connect a TI-73 calculator to a computer with internet access using a TI Silver 

Graph Link. Be sure to turn on the calculator. 
• Google and Bookmark the website (appearance of the Texas Instruments website 

may differ): http://education.ti.com/us/product/apps/probsim.html 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. TI requires a registration/login process to the website. Registration/Login process 
follows: 
 
A. Google/Browse to website, if bookmarked use bookmark: 

http://education.ti.com/us/product/apps/probsim.html  
 

* 
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B. Select download for the appropriate calculator. For Example: TI-73 Explorer (*) 
was selected. If a Security Alert window pops up click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

* 
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C. The registration/login process will begin at this point. Select New User 
Registration (*) or input User Name and Password. Personal information and an 
agreement with terms will follow for new users, as illustrated below (*). If a 
Security Alert window pops up click YES.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

* 

* 
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2. You will need to download the TI-73 Explorer(tm) Operating System first, 
followed by the Probability Simulation (*). For Example: TI-73 Explorer(tm) 
Operating System was selected first. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the TI-73 Explorer(tm) Operating System, select Save (*), and save to the 
Desktop. Download will begin. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2nd* 
1st*

*

*

*
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4. Once download is complete, minimize the window, My Pick-Up…. A TI Operating 

System icon    will appear on the desktop. 

5. Click and drag the TI Operating System icon    onto the  

TI Connect icon  . 
 

6. A OS Download Warning will appear, click OK. (Note: all applications on the 
calculator will be deleted when upgrading to the new operating system.) 
 
 
 
 
 
 
 
 
 

7. Transferring of the operating system to the TI-73 calculator will begin. While the 
operating system is transferring, the graphing calculator will read: Receiving 
Calculator Software. This process will take about 5 to 10 minutes. Once you have 
downloaded the operating system, the calculator will read: Validating Calculator 
Software followed by Graph Explorer Software 1.60 title screen. 
 
 
 
 
 
 
 
 
 
 
 
 

8. Maximize the window, My Pick-Up. Repeat steps 2-5 for downloading the 
Probability Simulation. If a Document and Setting window pops up click and OK, 
then restart download by selecting the Probability Simulation again.  
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9. Transferring of the Probability Simulation APPS will begin and the TI-73 calculator 
will read: Receiving Pro Sim APP. This process will take about 1 minute. 

 
 
 
 
 
 
 
 
 
 
 
 

10. Check to see if you have downloaded the Probability Simulation APPS correctly 
onto the calculator, by selecting the 9 key on the calculator. If the download was 
successful a new application titled Prob Sim will be in the list. 
 
 
 
 
 
 
 
 
 

11. Drag to trash the TI Operating System and the Probability Simulator icon to the 
trash can and delete. 



  Grades 6 - 8 
 
 

TMT3 Grades 6 - 8: The Big Question Spreadsheet  232 

Technology Tutorial:  TI-Interactive: The Big Question 
Presenter(s) Spreadsheet 

Create a Presenter(s) Spreadsheet before starting the activity. This will enable the 
presenter(s) to flow between each group’s data efficiently. 
 
Advance Preparation 

• Load TI-Interactive 1.3 software (will need to be purchased) onto computer: 
See TI-Interactive instructions manual. 

• Load TI-Connect 1.5 software onto computer: See Loading TI Connect 
Technology Tutorial. 

 
Create Presenter(s) Spreadsheet 

1. Open TI-Interactive  . 
 

2. In the toolbar select the Spreadsheet icon  . 
 
 
 
 
 
 
 
 
 

3. A spreadsheet will be activated in the form of a Data Editor. 
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4. Starting with cell A1 click and drag to the lower right-hand side of the spreadsheet 
until all cells are highlighted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. In the tool under the Format menu select Cells. 
 
 
 
 
 
 
 

6. Set Alignment to Center and Number Format to General, select Apply and then OK. 
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7. Click on cell B2 and type in Possible Outcomes, then Enter. Continue until you have 
set up all labels and groups. Some columns may need to be resized; instructions for 
resizing are below illustration. Note: if more than five groups are needed just include 
another column labeled accordingly. Also, if fewer than five groups participate in the 
activity, having extra columns set up will not affect the outcome of the calculations. It 
is better to have too many groups set up, than too few. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
To resize column width or roll height: move curser into the column labels (or roll 
labels) when the curser changes from a pointer to a two sided arrow (*) and a 
resizing line appears, click and drag to the desired size. 
 
 
 
 
 
 
 
 
 
 
 

 
 

*
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8. Click on cell C3, in the toolbar select Functions ( ( )f x ). 
 
 
 
 
 
 

9. Scroll down to SUM, and then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Highlight cells E3 to I3. Note: There will be changes in the Sum formula as you 
highlight the cells. Enter a close ()) parentheses and then Enter. Also, the sum will be 
zero at this time. 
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11. Repeat steps 9-11 for cells C4, C5, C6, C7, and C8 using the corresponding Group 
cells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. Click on cell B10, and input label, Total Trials. Click in cell B11 and use the sum 
formula to total the frequency column, this will require highlighting cells C3-C8. 
Enter a close ()) parentheses and then Enter 
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13. Table with formatted cells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. Click on the C column. In the toolbar under the Insert menu select Cells. In the pop-
up menu select Shift cells right and click OK. 
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15. Resize new column as explained in step 7, and input label Experimental 
Probability. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
16. Click in cell C3. Enter  =  followed by clicking on cell D3, backslash and cell G14, 

and then Enter 
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17. Repeat step 16 for cells C4, C5, C6, C7, and C8 using the appropriate corresponding 
cells.  

 
Note: Due to division by zero an error message will appear until data has been entered. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
18. In the toolbar under the File menu select Save To Document. Save to the Desktop as 

The Big Question. 
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Technology Tutorial:  TI-Interactive - The Big Question 
Graph 

 
Create a Presenter(s) Spreadsheet before starting the activity. This will enable the 
presenter(s) to flow between each group’s data efficiently. 
 
Advance Preparation 

• Create The Big Question Presenter(s) Spreadsheet using the Technology 
Tutorial: The Big Question Present(s) Spreadsheet. 

 
Create Presenter(s) Graph 
1. Open TI-Interactive: Middle School-Explore Explain 3 Spreadsheet.tii or The Big 

Question spreadsheet (if formatted by presenter.) 
 

2. Double click on the graphic (*). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* 
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3. Have one group at a time input their results for each outcome. Once two or three 
groups have inputted data, highlight the Possible Outcomes and Experimental 
Probability columns, by clicking on cell B3 and dragging to cell C8. 
(If using TI-83 calculators, data may be collected using a linking device between the 
computer and a calculator. Steps for linking and importing data can be found at the 
end of this tutorial.) 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. In the toolbar select the Graph icon  . Note: The graph icon may look different 
based on the last type of graph created. In the Graph menu select the Y= graph icon  

. 
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5. Notice the sample shows data plotted, and corresponding cell ranges set under Stat 
Plots in the Functions window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Reset point size by clicking on the Point Selection Box, and selecting 3 in the Size 
drop-down menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*
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7. Reset point color by selecting Black in the Color drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*
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8. Click Format (*), under Window set the x- and y-axis minimums and maximums as 
shown, click Apply, and then OK. 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* 

*
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9. Under Y= in the Function window input the appropriate function. The leader notes 
for this activity discuss function.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
10. Reset the line width by clicking on the Line Selection Box, and selecting the second 

width choice in the Weight drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

* 
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11. Reset line color by selecting Black in the Color drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12. Have another group input their data, continue process as classroom discussion 

continues 
 

13. Close Middle School-Explore Explain 3 Spreadsheet.tii  or The Big Question 

using the close box  . 
 

 
 
 
 
 
 
 

*
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Importing Data using a Linking Device 
One at a time each group of participants will connect their calculator to the computer 
using a TI-Graph Link USB. Make sure the calculator in turned on, and at home screen. 
 
*Note: Graphic of tables may differ, but procedure is the same. 
 
1. Open TI-Interactive: Middle School-Explore Explain 3 Spreadsheet.tii or The Big 

Question spreadsheet (if formatted by presenter.). 
 

2. Double click on the graphic (*). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the List tab at bottom of spreadsheet. 
 
 
 

 
 

 
 
 
 

* 

*
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4. Select the Import TI Device Data icon on the Toolbar. 
 
 
 
 
 

 
Follow instruction and select the list that contains the data you intend to import. 
(Instructions will vary here depending on what type of calculator the participants use.) 
 
5. Data will import into the appropriate list: In the example, data were in L1 of the 

calculator; therefore they were imported into L1 in the list editor.  
 
 
 
 
 
 
 
 
 
 
 

6. Highlight data as shown above and select Copy in the Edit menu. 
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7. Select the Spreadsheet tab. 
 
 
 
 
 
 
 
 
 
 

8. Highlight the first cell under the appropriate Group, and select Paste under the Edit 
menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Data will be imported into the appropriate cells. 
 

 
 
 
 
 
 
 

*
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Technology Tutorial:  Trials, Trials, Trials Activity 
 

The following is an example: participants may create a table and labels independent of 
this example. Therefore participants table and graph will vary. 
 
Creating the Table 

1. Open an Excel    document. 
 

2. The following illustration is the product created in steps 3-7. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on cell A1 and drag to cell D10. 
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4. In the toolbar under the Format menu, select Cells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Under the Alignment tab, use the pop-down menu under the Horizontal and Vertical 
text alignment to select Center. Select Wrap Text by clicking in the box under text 
control. Click OK. 
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6. Click cell B4 and enter Different Outcomes, and click on cell C4 and enter 
Frequency. If needed, adjust the size of the cells by clicking on the line to the left of 
the column and dragging the line left or right as needed. (Short cut: Use the down 
arrows on your keyboard to move down the column.) 
 
 
 
 
 
 
 
 
 
 
 

7. Click on cell B5 and enter 1, continue entering 2-6 in the cells below as illustrated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Table is complete and ready to input data from the Group Activity Sheet: 
Simulation #1 frequency table. Input data using cells C5-C10. (Example uses the 
data found in the leader notes.) 
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Creating the Graph 
Participants may select the type of graphical representation of their choice; therefore, two 
possible types of graphs appear: Bar Graph, and Pie Graph. You may want to 
experiment with others. 
More than one graph may be created and displayed side by side. 
 
Bar Graph 
 
1. Click and drag curser over the data to highlight. The example has cells C5-C10 

highlighted. 
 
 
 
 
 
 
 
 
 
 
 

2. Select the Chart Wizard    in the toolbar. 
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3. Step 1: Select the Column chart type, then click Next.  
Step 2: Since the data was highlighted first click Next. 
Step 3: Input a Chart tile (Trials, Trials, Trials), Categories (X) axis (Possible 
Outcomes), and Categories (Y) axis (Frequency), then click Next. 
Step 4: Select As object in, and then Finish. 
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4. A graph will appear on the spreadsheet. 
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Pie Graph 
1. Complete steps 1 and 2 of the Bar Graph on page 4. 
 
2. Step 1: Select the Pie chart type, and then click Next.  

Step 2: Since the data was highlighted first click Next. 
Step 3: Input a Chart tile (Trials, Trials, Trials), then select the Data Labels tab and 
check Category name, Percentage and click Next. 
Step 4: Select As object in, and then Finish. 
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3. A graph will appear on the spreadsheet. 
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Technology Tutorial:  TI-73: Trials, Trials, & More Trials 
Activity with APPS 

 
Notice there are two different sets of Simulation Cards. The best scenario is to use 
Simulation Card Set 2 With APPS Program. Card set 2 with APPS Program requires 
the Probability Simulator APPS, you can perform the activity without the simulator 
using Card Set 2 without APPS Program.  
The following is an example: participants will generate different data independent of this 
example. Therefore participant’s data and list will vary. 
 
Advanced Preparation 

Check all calculators for the Probability Simulator APPS by checking the  9  
list for Pro Sim. 
 
 
 
 
 
 
 
 
 
If the applications list does not contain the Probability Simulator APPS, then refer 
to the Technology Tutorial Loading TI Probability Simulator APPS and load the 
application software. 
 
 

Trials, Trials, & More Trials with Probability Simulator 
1. Press  ^. 

 
2. Press  9. 

 
3. Select the Probability Simulator, Prob Sim. Press  b  twice. 
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4. Follow the instructions below for each specific simulation. 
 

 
Number Cube 

A. Select Roll Dice. Press  b. 
 
 
 
 
 
 
 
 
 

B. Press  '  which will activate the first roll of the die. Continue pressing  
'  until you have recorded 10 rolls. 
 
 
 
 
 
 
 
 
 

 
Spinner 

A. Select Roll Dice. Press  b. 
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B. Press  (  to activate settings. Using the arrow keys: set Sections to 6 and 
Graph to Freq. Press  *. 
 
 
 
 
 
 
 
 
 
C. Press  '  which will activate the first spin. Continue pressing  '  
until you have recorded 10 spins. 
 
 
 
 
 
 
 
 
 

5. To quit Probability Simulation: Press &. 
 
 
 
 
 
 
 
 
 
6. Press  &. 
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7. Press  *. 
 
 
 
 
 
 
 
 
 

8. Press  &. 
 
 
 
 
 
 
 
 
 
 
 
 

Creating a Line Plot 
1. Press  ^. 

 
2. Press  3. 

 
 
 
 
 
 
 
 
 

3. Input the possible outcomes into L1 (list 1), one at a time. Press  b  each time. 
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4. Curser over to L2 (list 2) using the arrow key  ". Input the frequency of each 
possible outcome one at a time. Press  b  each time. 
Record frequencies in the Groups Activity Sheet: Simulation #2 table. 
In this example: 2, 6, 1, 7, 4, 0 will be the frequencies of the six possible outcomes  
 
 
 
 
 
 
 
 
 

5. Press  -&. 
 
 
 
 
 
 
 
 
 

6. Select Stat Line. Press  b. 
 
 
 
 
 
 
 
 
 

7. Using the curser keys and b, select Plot 1 On, Type Line Plot, Xlist L1, and 
Ylist L2. 
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8. Press  '. Set window using illustration. 
 
 
 
 
 
 
 
 
 

 
 
9. Press  *. 

 
 
 
 
 
 
 
 
 

10. To quit: Press  -.. 
 

11. Press  -^. 
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Technology Tutorial:  TI-73: Trials, Trials, & More Trials 
Activity with No APPS 

 
Notice there are two different sets of Simulation Cards. The best scenario is to use 
Simulation Card Set 2 With APPS Program. Card set 2 with APPS Program requires 
the Probability Simulator APPS, the activity can be done without the simulator using 
Card Set 2 without APPS Program.  
The following is an example: participants will generate different data independent of this 
example. Therefore participant’s data and list will vary. 
 
Trials, Trials, & More Trials with No Probability Simulator 
1. Press  ^. 

 
2. Press  1. 

 
 
 
 
 
 
 
 

3. Curser over to the 1  PRB menu using the " key. 
 
 
 
 
 
 
 
 
 

4. Follow the instruction below for each type of simulation. 
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Number Cube 
A. Select dice(. Press  b. 

 
 
 
 
 
 
 
 

B. To simulate 5 rolls of a die: Enter  RE. 
 
 
 
 
 
 
 
 
 

C. Press  b, which will generate the first 5 rolls. 
 
 
 
 
 
 
 
 
 

D. Press  b, to generate the next 5 rolls. 
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Number Generator  
A. Select randInt(. Press  b. 

 
 
 
 
 
 
 
 
 
 

B. To generate 5 random integers between 1 and 6: Enter  Y¡S¡RE.  
 
 
 
 
 
 
 
 
 

C. Press  b which will generate the first five numbers. 
 
 
 
 
 
 
 
 
 

D. Press  b which will generate the next five numbers. 
 
 
 
 
 
 
 
 
 

5. To quit: Press  -^. 
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Creating a Line Plot 
1. Press  ^. 

 
2. Press  3. 

 
 

 
 

 
 
 
 

3. Input the possible outcomes into L1 (list 1), one at a time. Press  b  each time. 
 
 
 
 
 
 
 
 
 

4. Curser over to L2 (list 2) using the arrow key  ". Input the frequency of each 
possible outcome one at a time. Press  b  each time. 
Record frequencies in the Groups Activity Sheet: Simulation #2 table. 
In this example: 2, 6, 1, 7, 4, 0 will be the frequencies of the six possible outcomes  
 
 
 
 
 
 
 
 
 

5. Press  -&. 
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6. Select Stat Plot 1. Press  b. 
 
 
 
 

 
 

 
 
 

7. Using the curser keys and b, select Plot 1 On, Type Line Plot, Xlist L1, and 
Ylist L2. 
 
 
 
 
 
 
 
 
 

8. Press  '. Set window using illustration. 
 
 
 
 
 
 
 
 

 
9. Press  *. 

 
 
 
 
 
 
 
 
 

10. To quit: Press  -.. 
 

11. Press  -^. 
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Technology Tutorial: Importing Data and Charts 
 

1. To import data, “click and drag” to highlight the cells containing the data and data labels. 

 
2. Right click on the highlighted cells. Click on Copy. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Click on the appropriate file on the menubar to open the document that will contain your 

imported data. 
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4. Right click on this document. Click on Paste. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. The highlighted cells will be imported into your document.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Use the same process to import a chart.  
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Technology Tutorial: Importing Screen Shots 
 
1. To import screen shots from a graphing calculator, TI Connect must be loaded onto the 

computer.  
 
2. Link the TI-73 graphing calculator to the computer using a TI Connectivity Cable Serial for 

Windows® (black). 
 
3. Double click on the TI Connect icon on the desktop. 

 
 
 
 
 
 
4. Click on the TI ScreenCapture Icon. 
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5. The Screen Capture window will open up. The screen shot containing whatever is presently 

displayed on your graphing calculator will be displayed within this window. Click on the 
Add/Remove Border icon to add a border to your screen shot. 
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6. Click on Edit on the menubar. Click on Copy to copy the image to the clipboard. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Click on the appropriate file on the menubar to open the document that will contain your 
imported data. 
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8. Right click on this document. Click on Paste. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9. The screen shot will be imported into your document as shown below. 

 
 


